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Administrating TextMap

Managing Case Staff

Managing case staff

One way to add security to your case is to add staff members to your case. You can add staff
when you are first creating a new case with New Case Wizard. Or you can add staff any time.
Adding new staff also allows staff members to add a password for the case.

Your IT or litigation department may have established guidelines for case security. Your
organization may choose to:

Not add staff members

Add staff members, but do not have the staff members set a password

Add staff members, and then set a company-wide password for all cases

Add staff members, but then set a case-specific password

Add staff members, and then have staff members set unique passwords for each case

Add network folder level security and leave staff passwords as blank (recommended)

New cases are not protected by passwords until you or other users create them.
Passwords automatically default to blank, so you would simply type a password and verify
it, and then click OK to save it. If you forget your password, you need to call CaseMap
Technical Support to have them reset it for you.

We recommend that you apply case security at the network folder level. This allows users
to keep the default password set to blank, but ensures case security where the case is
saved.

You cannot add, modify, or delete users for SQL cases in TextMap. Managing SQL case
staff is done in the CaseMap Admin Console.

Related Topics

Adding users to cases

Setting/changing case passwords

Deleting users
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Replicating and Synchronizing

About replicating/synchronizing cases

Replication and synchronization are TextMap features that permit case staff to work in replica
copies of a master case (local or SQL) that can be merged to create one updated version of the
master case. You can create replicas of local and SQL cases in TextMap.

Replication vs. Synchronization:

Replication is creating an exact copy of a case while tracking the replicated file

Synchronization is merging the replica to the master case, reconciling any updates or edits

When case users go on the road, they can take a replica along and make additions and
updates to case records. While these individuals work in replicas, case staff back in the office
can still make changes to the master case. When the replica is returned or emailed to the
office, the latest content can be synchronized into the master case.

With TextMap, a replica can be synchronized repeatedly with the master case — without
creating duplicate transcripts, annotations and redactions. This allows users on the road to
email replicas back to the main office for synchronization each time significant updates are
made, while continuing to work in the replica.

All replica name (local and SQL versions) must be unique. Creating a replica of a TextMap case
is an exclusive process. Case staff cannot access the master case during this process.

A replica cannot be created if users are actively working in the case (synchronizing cases, or
importing, updating, and deleting transcripts). Please notify case users to exit the case before
creating a replica of a case. Password protection of replica is optional, however at least one
user must be assigned to the case before a replica can be created.

Create replica cases for staff who need to work from home or access a case during court
or offsite depositions. Replica cases include access to linked files and exhibits, with the
exception of Web sites and links to files in document management systems.

For information on how to create a SQL case replicas in the CaseMap Admin Console, refer
to the CaseMap Server Answer Center.

Follow these guidelines to ensure synchronization success

Reference the following table for guidelines and considerations when replicating and
synchronizing cases.

Replication and Synchronization Guidelines and Considerations

Replica copies can be saved to a network folder and shared among users.

At least one user must be added to a case before a replica can be created; passwords are
optional.

http://help.lexisnexis.com/litigation/ac/ac_portal/index.html?welcome.htm
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Replication and Synchronization Guidelines and Considerations

Case staff in the master case are exported to the replica for both local and SQL cases.

* If you add additional staff to a replica, they are not added to to the master case when
synchronization occurs. For a local case, add new users by clicking Tools > Case Staff. For
a SQL case, new users are added in the CaseMap Admin Console and need to then be
assigned to a role and the SQL case.

A replica cannot be created if users are actively working in the case (synchronizing cases,
or importing, updating, and deleting transcripts).

You can make as many replica of the master case as needed.

Replicas can be synchronized with the master case repeatedly; allowing users to continue
working in the replica while emailing updated copies back to the office for synchronization.

Always merge replica copies with the master case when they are returned, regardless if a
user says updates were not made to the file.

Exported copies of the case cannot be synchronized with a master case. Only copies made
during a replication process can be synchronized.

Convert replicas to create a new master case when a case file corrupts, information is lost
on the network, or backups are lost/corrupt.

* In this instance, any transcripts or additional information added in the corrupt master
case that does not exist in the replica may need to be imported/added to replace lost
data.

See the Synchronization Rules for Issues table in this help topic for limitations regarding
issues in a TextMap replica.

Reference specific synchronization rules for issues

Reference the following table for specific synchronization rules, particularly regarding issues.

Synchronization Rules for Issues

TextMap only supports adding issues from one case to another. The synchronization
feature does not change the issue outline hierarchy in the master case if you have
rearranged it in the replica.

TextMap adds new issues to ensure that links are not lost. TextMap ignores the issue
outline arrangement, issue colors, and renamed or deleted issues when adding issues
from the replica.

After synchronization completes, case staff must combine duplicate issues or remove
unwanted issues. The Delete Issue Wizard allows you to move links from one issue to
another. If the issue is linked to any annotations, the Delete Issue Wizard displays.
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Synchronization Rules for Issues

TextMap matches issues from one case to another by issue name only. If new issues are
created in the replica, they are only added as a new issue in the master case if they are
linked to annotations.

* Issues that are added, edited, renamed, or deleted in the replica, and are not linked to
an annotation, are not updated in the master case when synchronization occurs.

TextMap does not synchronize the following issue changes:

Issue outline levels or order

Issue names

Issues deleted in the replica are not deleted in the master

Issues deleted in the master are added back when synchronizing with a replica

TextMap does copy links for new annotations to the master case.

TextMap completely replaces annotations that are edited in a recent replica. The replica
copy of the annotation is synchronized into the master case if the Last Update Time Stamp
in the replica is later than that of the master case's Last Update Time Stamp.

Reference specific synchronization rules for redactions

Reference the following table for specific synchronization rules, particularly regarding
redactions.

Synchronization Rules for Redactions

TextMap creates new redactions in the master case that do not exist in the existing
transcript.

Redaction reasons are created in the master case if the reason does not exist in the
existing transcript.

TextMap synchronizes the following changes into the master case for redactions that
already exist:

For single redactions, the existing redaction will expand to cover the newly selected
transcript text.

For multiple redactions, the existing redaction will expand to cover the newly
selected transcript text, but once merged, they will not retain any creation or update
history. 

Related Topics

Creating replica cases

Synchronizing cases
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Taking video transcripts offline

Creating replica cases

The Create Replica Wizard guides you through the steps of creating a replica copy of for local
and SQL cases. The wizard offers options for how you want to save the replica. You can save a
replica copy on your computer along with copies of linked documents. Or you can save the
replica to a specific location on your network or email it. The last two options do include copies
of linked documents.

If you are working with SQL cases, the replication process is nearly identical to creating a
replica of a local case. At least one user must be assigned to a SQL case in the CaseMap
Admin Console before a replica can be created. All users assigned to a SQL case will be
exported when the replica is created. For SQL cases, you also have the option to
password protect the replica.

Synchronization of all replicas with the master case is done in the TextMap client
application. If new users are added in the replica, they must also be added in the
CaseMap Admin Console as users and be assigned to the case for synchronization to be
successful.

For more information on how to create a TextMap SQL case replica in the CaseMap Admin
Console, see the following topic: Creating replica SQL cases in the CaseMap Server
Answer Center.

To create a case replica

1. In TextMap, open the case for which you want to make a replica.

2. On the File menu, click Synchronize, and then click Create Replica.

3. When the Create Replica Wizard launches, click Next.

4. In the Why are you creating this replica? dialog box, choose where you want to save
the replica.

http://help.lexisnexis.com/litigation/ac/ac_portal/index.html?welcome.htm
http://help.lexisnexis.com/litigation/ac/ac_portal/index.html?welcome.htm
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Select Yes, I want to take the replica offline on this computer to save the replica and
copy linked documents.

Select No, I do not want to use the replica on this computer to save the replica to
another location. You cannot copy linked documents when selecting this option.

5. Click Next to continue.

6. In the Name and Location dialog box, type in a name for the replica.
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7. Click Browse to navigate to the folder where you want to save the replica, then click
Next.

8. In the Offline Access to Case Exhibits dialog box, select whether you want offline
access to linked documents while working in the replica.
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Yes, copy the linked files to the folder below to access the documents offline

1. Click Next to access the Offline Document Access Overview dialog box to review how
many files are linked to the case, and how many TextMap can copy for you to use
offline.
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2. Select the Show me detailed information on the linked files when I click Next
check box to view a listing of linked files that cannot be copied, then click Next.

3. In the Linked Files Not Supported dialog box, review the list of files that cannot be
copied, such as linked documents that reside on web sites. TextMap will copy web
site addresses to the replica.
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4. Click Next to access the Linked Files to Copy dialog box and review a listing of all
documents that can be copied.
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Linked files are saved in an Exhibits folder to the same location you specified to save
the replica.

No, I don't want offline access to the linked files

When this option is selected, linked documents will not be copied when the replica is
created.

Click Next to access the Email or Save to File dialog box.



TextMap16

© 2017 LexisNexis. All rights reserved.

I want to email this replica

1. Click Next to open the Emailing the Replica dialog box.

2. In the File Name field, type in the name of the replica, then click Next.

3. In the Reduce Email Attachment Size dialog box, select whether you want to
create a zip file of the replica before attaching it to the email, then click Next.

4. Click Finish when the process completes.

A Microsoft Outlook email opens with the replica case attached and information
regarding the file that can be customized according to your needs.

I want to save the replica to a file

1. Click Next to open the Name and Location dialog box.

2. In the File Name field, type in the name of the replica.

3. Click Browse to navigate to the folder where you want to save the replica.

9. Click Next to continue.

10. In the Ready to Create Replica dialog box, verify the path where the replica will be
saved, then click Next.

11. In the Completing the Create Replica Wizard dialog box, click Finish when the process
completes.
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The Case Log On dialog box displays so you can log back in to the master case.

The replica is now saved to the location specified and is ready for use. When the the
replica is opened, it will display [Replica] in the case name.

Related Topics

About replicating/synchronizing cases

Synchronizing cases

Taking video transcripts offline

Synchronizing cases

Synchronization in TextMap allows you to update the master case with new transcripts, coded
issues, and added annotations made in the replica. During this process, TextMap analyzes the
differences between the two cases and copies changes made in the replica to the master case.

Synchronization may take a few minutes depending on the number of transcripts, annotations,
redactions and words in the transcripts to be indexed during the process. TextMap does not
create duplicates of transcripts, annotations or redactions during synchronization, but updates
existing transcripts with the new annotations and redactions. Refer to the About replicating/
synchronizing cases topic for details on guidelines, considerations, and limitations for this
process.

If you are working with SQL cases, the replication process is nearly identical to creating a
replica of a local case. At least one user must be assigned to a SQL case in the CaseMap
Admin Console before a replica can be created. All users assigned to a SQL case will be
exported when the replica is created.

Synchronization of all replicas with the master case is done in TextMap. If new users are
added in the replica, they must also be added in the CaseMap Admin Console as users and
be assigned to the case for synchronization to be successful.

For more information on how to create a SQL case replica in the CaseMap Admin Console,
see the following topic: Creating replica cases in the CaseMap Server Answer Center.

To synchronize a case

1. In TextMap, open the case for which you want to make a replica.

2. On the File menu, click Synchronize, and then click the Synchronize button.

3. In the message box, click OK.

4. In the Select another TextMap case to synchronize with dialog box, navigate to the
case you want, then click Open.

http://help.lexisnexis.com/litigation/ac/ac_portal/index.html?welcome.htm
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5. In the message box listing, review identified transcripts, annotations and redactions to
synchronize, click Yes to proceed.

The master case now includes updates made from the replica.

After synchronization completes, case staff must combine duplicate issues or remove
unwanted issues. The Delete Issue Wizard allows you to move links from one issue to
another.

Related Topics

About replicating/synchronizing cases

Creating replica cases

Taking video transcripts offline

Taking video transcripts offline

If you have imported video transcripts into your case, you can copy the files to your computer's
hard drive so you can play them offline. You can copy video transcripts to your computer's hard
drive by using a portable device (like a USB drive). Or you can burn a copy of the original CD to
take with you and play the video files directly from the CD.

If you create a replica of the case that includes video transcripts and try to play them on your
laptop, TextMap tries to locate the file in its original stored location. If it does not locate the
video file (especially if it is stored on your network), then a message displays in the Browse For
Folder dialog box that displays the video file name.
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If you have a copy of the video transcripts files stored on your laptop, then you can navigate to
the folder on your hard drive to locate the file and play it. If the video transcript files are copied
onto a CD, then you can navigate to the laptop's CD/DVD drive (often D: instead of E: on your
office computer). Browse to and then select the folder/drive where the video is located, then
click OK.

Related Topics

About replicating/synchronizing cases

Creating replica cases

Synchronizing cases

Managing the Case Index

About the case index

TextMap creates a word index when you import transcripts into a case. TextMap reads the case
data and compiles an index based off each word it reads. The index is used when you run
searches so you can locate important words, dates, and text phrases easily in your case
transcripts and linked files.

When you import new files into a case, TextMap will update the case index to include those files
so you can capture the data in new searches or re-run previous searches on the new files. We
recommend that you do not run searches while the indexing process is occurring because you
may not receive complete search results until all new files have been indexed. If you do run a
search when the index process is still running, a message displays at the top of the Search
Results pane that states: Results may be incomplete; TextMap was updating the index when
you ran the search.

If another case user has indexed the case using a previous or later version than you have
installed, you may not be able to index the case until you upgrade to the latest TextMap
version. To search in the current case, you need to rebuild the index or upgrade to the latest
version of TextMap.

TextMap indexing only works in version 7 cases; indexing is not backwards compatible on
previous version cases. If TextMap encounters a problem during the index process, it will
disable indexing for the case. You may continue to use the case, but the Search functionality
will not be available. We recommend that you close the case and reopen TextMap. If the
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problem continues, contact CaseMap Technical Support at 800.833.3346 (option 3) or 
casemap.support@lexisnexis.com.

As new or updated transcripts are imported into the case the index rebuilds and the word
count reflects an updated total as new words are added to the list. You can also rebuild the
index in a case.

TextMap indexes:

New or updated transcripts

Annotations and notes

Case issue names

Linked exhibits

TextMap automatically indexes edits to annotations, notes, and case issue names. Similarly, if
you delete an annotation, note, or issue, the index is automatically updated to reflect the
changes.

Learn why some words are not indexed

TextMap comes with a pre-defined list of ignore words that it skips while indexing case
information. Ignore words are words that are automatically excluded from a case index. The
ignore word list includes the most common words in the English language (and, but, is, if,
the). Ignore words are words you would generally not search for. Eliminating these words
from the index ensures that searches run faster and more efficiently.

You can also modify the ignore word list. See Modifying ignore words.

To verify if indexing is complete

1. In the lower right corner of TextMap, move the mouse pointer over the Index icon .

2. Now look in the lower left corner of TextMap to see whether the  message
displays.

If this message displays, you can run your search and get the latest search results on
case data.

If this message does not display, the reindexing process is still running and it is best to
run any searches after it completes. When the indexing process is running, the icon

changes to display a clock .

Related Topics

Rebuilding the case index

Viewing linked exhibit index status

Modifying ignore words

About searching

mailto:casemap.support@lexisnexis.com
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Viewing linked exhibit index status

The Linked Exhibit Index Status dialog box allows you to track your case index status for files
that were successfully indexed and those that were not indexed. The Not Indexed tab lists
each file that failed during indexing and provides the applicable reason code. You can try to
reindex files that were unsuccessful and then refresh the list to see if it was later indexed. You
can also save a report of all indexed or non-indexed files for reference purposes.

TextMap indexing considerations include:

TextMap does not index some media files (.mpg. .wmv, .avi). These files types will display in
the Not Index tab of the Linked File Index Status dialog box.

Media files that can be indexed but are corrupt or otherwise encounter an error during the
OCR process will display in the Failed tab of Linked File OCR Status dialog box.

TextMap does not index links to document management systems like Concordance or
CaseMap.

TextMap does not index URLs (including linked files to Concordance EV).

TextMap does index file paths with more than 260 characters or that contain invalid
characters.

TextMap cannot index files locked as read-only.

TextMap cannot index files or files saved in folders that contain insufficient permissions.

TextMap cannot index encrypted PDFs.

TextMap cannot index corrupt files or non-exist local files.

To view linked exhibit index status

1. On the Case Tools ribbon, click Case Index.

2. On the submenu, click Linked Exhibit Index Status.

3. In the Linked Exhibit Index Status dialog box, click the Indexed tab to view a list of all
documents that were successfully added to the case index.
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You can sort the Linked File list in ascending (default) or descending order.

Linked files display an icon depicting its file type.

4. Optional: Click the Not Indexed tab to view all documents that did not index properly.

The Reason column provides a description for why the document was not indexed.

You can sort the Linked files that have not been index and Reason columns in ascending
(default) or descending order. You can also resize the columns within the tab.

TextMap does not support indexing linked files that are URLs to a website or to a
document management system.

5. To try indexing a file again, select the file displaying in the Not Indexed tab and then
click the Retry button.

6. In the message box, click OK.

7. Click the Refresh button to ensure that the most current information displays on each
tab once indexing is complete.

8. Click Close when you are finished.

To print a Linked Exhibit Index Status report

1. On the Case Tools menu, click Case Index.

2. On the submenu, click Linked Exhibit Index Status.

3. In the Linked Exhibit Index Status dialog box, click the tab for which you want to save
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the data: Indexed or Not Indexed.

4. Click the arrow on the Report button and then click Save Standard Report or Save
Debug Report.

5. In the Save Report dialog box, navigate to the folder where you want to store the
report.

6. Click the Save button.

The file is saved as a .csv file in the folder you selected.

When you click on the Report button, there is an option for Save Debug Report. This
report option is for CaseMap Technical Support to use in resolving issues with a file that
did not index properly.

Related Topics

About the case index

Rebuilding the case index

Modifying ignore words

Viewing linked exhibit OCR status

Rebuilding the case index

You can rebuild case indexes to restore an index in a copy of a case. For more information, see 
Creating replica cases.

Reasons to rebuild the case index:

When you need to restore the index in a copy of the case (if you think the index is possibly
corrupt or out of sync).

When you have edited the Ignore Word list.

To rebuild the case index

1. On the Case Tools menu, click Case Index.

You can also right-click on the Index icon  in the lower right corner of TextMap and click
Rebuild case index.

2. On the submenu, click Rebuild Case Index.

3. In the message to confirm the process, click Yes.
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The index rebuild process automatically starts and runs in the background while you
work in the case.

If you run a search while rebuilding the index, a message displays that states this
process is running and the search you are trying to run may not return precise results.
We recommend that you wait until the process completes before running a search.

Related Topics

About the case index

Viewing linked exhibit index status

Modifying ignore words

Creating replica cases

Modifying ignore words

TextMap provides you with a default, global Ignore List and a Case Ignore Words list. Both lists
are used by TextMap to skip or ignore words and text from both lists during searches. Words or
alphanumeric text can be added or deleted from either list.  When search queries are
performed, any words or text added to the lists are skipped and not included in search results
or tallied as search "hits".

Ignore List vs. Case Ignore Words

Ignore List — This is TextMap's default, global listing of all ignore words and is
automatically included when each case is created. Any changes you make to the Ignore List
will apply to the current case and all future cases created in TextMap. Access the default
Ignore List from the Tools menu by clicking Options and clicking the Ignore Words tab.

Case Ignore Words — Any additions or deletions you make the the Case Ignore Words list
apply to the current case only. Access the Case Ignore Words list from the Tool menu by
clicking Case Index and then clicking Case Ignore Words.

If you modify the ignore word lists, you will want to rebuild the case index to reflect those
changes. See Rebuilding the case index.

When you create new cases, you may want to review words included in the Ignore List
from previous cases. Use the Case Words Ignore List to add words that are specific to
current case needs.

You can export either ignore word list to review all words or print a list of words to reference. 
You can also import the ignore word lists to use in other cases.

To modify the Case Ignore Words list
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1. On the Case Tools ribbon, click Case Index and then click Case Ignore Words to open
the Ignore Words dialog box.

2. Click the Add button to add a new term to the list.

3. In the Ignore Words dialog box, type in the new terms, then click OK.

4. Click the Delete button to remove a highlighted word from the list.

5. Click OK to save your changes.

To export the Case Ignore Words list

1. On the Case Tools menu, click Case Index and then click Case Ignore Words to open
the Ignore Words dialog box.

2. Click the Export button.

3. In the Export Ignore Words dialog box, locate the directory folder where you want to
save it.

4. In the File Name box, type in the name you want, then click Save.

You may want to name the ignore list file by case name or type, if you intend to import it
into other similar cases.

To import a Case Ignore Words list into a case

1. On the Case Tools menu, click Case Index and then click Case Ignore Words to open
the Ignore Words dialog box.

2. Click the Import button.

3. In the Import Ignore Words dialog box, select the Case Ignore Words list you want to
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import, then click Open.

The new Case Ignore List is now added to the case.

To modify the global Ignore List

1. On the File menu, click Options.

2. In the Options dialog box, click the Ignore Words tab.

3. Click the Add button to add a new term to the list.

4. In the Ignore Words dialog box, type in the new terms, then click OK.

5. Click the Delete button to remove a word from the list.

6. In the Default ignore words for new case only box, highlight the word and click the
Delete button.

7. Click OK to save your changes.

To export the global Ignore List

1. On the File menu, click Options.

2. In the Options dialog box, click the Ignore Words tab.

3. Click the Export button.

4. In the Export Ignore Words dialog box, locate the directory folder where you want to
save it.
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5. In the File Name box, type in the name you want, then click Save.

To import an Ignore List into a case

1. On the File menu, click Options.

2. In the Options dialog box, click the Ignore Words tab.

3. Click the Import button.

4. In the Import Ignore Words dialog box, select the file you want to import, then click
Open.

The new Ignore List is now added to the case.

Related Topics

About advanced searching

About the case index

Viewing linked exhibit index status

Rebuilding the case index

Managing OCR Processing

About OCR processing

By default, TextMap does not attempt to OCR a PDF that has already been processed. It
determines whether or not it should OCR a PDF based on how much searchable text it finds on
top of the image portion for each page, and whether that text is a consistent length on each
page (e.g., a header or footer repeated on each page).

After files are imported into a case and a case index is created, TextMap performs OCR (optical
character recognition) processing on image files so that the text content can be indexed for full-
text searching. TextMap runs the OCR process in the background. You can continue working in
the case but should to wait to search data or annotate files until processing completes and the
case is updated with the latest information.

TextMap OCR processes imported files one at a time until all files in the queue succeed. Once
OCR processing completes, TextMap will update the case index. You can then view the image
files, navigate search hits, and annotate images in DocManager.

You can easily check the case's OCR status by placing your cursor over the OCR icon  in the
lower right corner of TextMap. An OCR is idle message displays on the status bar when no files
are in queue for OCR processing. You can disable OCR processing on your computer. Other case
user's computers that have OCR enabled will process imported files and update the case for
you. 



TextMap28

© 2017 LexisNexis. All rights reserved.

View supported file formats

Supported File Formats

File Type Multi-page
Supported

Color Support (Black and White,
Grayscale, Color)

Bitmap (*.bmp) No All

JPEG (*.jpg, *.jpeg) No Grayscale, Color

Personal Computer
eXchange (*.pcx)

No All

Portable Document Format
(*.pdf)

Yes All

Portable Network Graphic
(*.png)

No All

Tagged Image File - LZW,
PackBits, Uncompressed
(*.tif, *.tiff)

Yes All

Tagged Image File -
Compressed G3/G4 (*.tif,
*.tiff)

Yes Black and White

Graphics Interchange Format
(*.gif)

No All

Related Topics

About importing data

Viewling linked file OCR status

Disabling OCR processing

Viewing linked exhibit OCR status

The Linked Exhibit OCR Status dialog box allows you to track your OCR processing status, to
include OCR files that:

succeeded

failed
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are marked as Do Not OCR

are still in the queue for processing

are PDFs that were skipped. 

If a file failed OCR processing, you can select it and try to OCR process it again. You can also
save a report of the OCR status for reference purposes. Media files that can be indexed but are
corrupt or encounter an error during OCR processing display in the Failed tab of the Linked File
OCR Status dialog box.

If you close the case or attempt to rebuild the index while the OCR processor is processing a
file on your computer, the image will not be processed. Any remaining images in the queue will
not be processed until you or another case user reopens the case. When the case is re-
opened, CaseMap automatically starts OCR processing for files in saved the queue.

If you prefer to disable OCR processing on your computer, click the Disable OCR button in the
dialog box's toolbar. Imported files will still be indexed and OCR processed when other case
users open the case and have OCR enabled on their computer.

Click the Refresh button to update the Linked File OCR Status dialog box with current
information. If you do not click the Refresh button, you cannot select a file(s) to stop it from
OCR processing.

The Retry button starts the OCR process again for any files selected. Once the images are re-
processed, the index is updated with the content. You can Retry any file that is not already
queued for OCR processing, including a file(s) that were previously marked as Do Not OCR, or
those where OCR processing was skipped. If OCR processing completed successfully for a file
since the last time the Linked File OCR Status dialog box was refreshed, the file would move
from the Queued tab to the Succeeded tab. If the file failed to process, it would display on the
Failed tab. If another case user had already marked it as Do Not OCR, then the file would
display on the Do Not OCR tab.

To view linked exhibit OCR status

1. On the Case Tools ribbon, click Case Index.

2. On the submenu, click Linked Exhibit OCR Status.

3. In the Linked Exhibit OCR Status dialog box, click the Succeeded tab to review linked
files that were successfully OCR processed.
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You can sort the Linked File list in ascending (default) or descending order.

Linked files display an icon depicting its file type and the number of pages per file.

4. Click on the Failed tab to view any files that failed OCR processing.
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Failed linked files display the reason code, the number of pages in the file, and the
computer name where OCR processing occurred.

If two linked files have the same computer name, they are sorted first by the Linked File
column, then by the Reason column.

You can sort each column in ascending (default) or descending order. You can also resize
each column.

5. To try indexing a file again, select the file you want and click the Retry button.

6. In the message box, click OK to OCR process the file and update the case index.

7. Optional: Click on the Do Not OCR tab to view files that will not be in queue for OCR
processing at this time.

8. Optional: Click on the Queued tab to view files that are still in queue for OCR processing
or are being OCR processed at this time.

9. Optional: Click on the Skipped PDF tab to view files were not in queue for OCR
processing, and the PDF was skipped.

10. Optional: Click the Report button to generate a report.

In the Save Report dialog box, validate/enter a file name for the report, and then click
Save.

11. Click the Refresh button to ensure that the most current information displays for each
tab.

12. Click Close when you are finished.

To reprocess skipped PDF files

1. On the Case Tools ribbon, navigate to Case Index and then click Linked Exhibit OCR
Status.

2. In the Linked Exhibit OCR Status dialog box, click the Skipped PDF tab. 

3. Select the documents you wish to reprocess and click on Retry. 

To stop files from OCR processing

Large files or corrupt files can easily be removed from OCR processing in the Linked
Document OCR Status dialog box. A large file (e.g., PDFs with a page that contains more
than 200 characters of searchable text on top of a scanned image) may still display on the
Queued tab because it takes too long to process. A corrupt file will display on the Failed tab
because it cannot be OCR processed. You can mark these files as Do Not OCR so they will
not be reindexed when rebuilding the case index.

1. On the Case Tools menu, click Case Index.

2. On the submenu, click Linked Exhibit OCR Status.

3. In the Linked Exhibit OCR Status dialog box, click the tab you want to view: Succeeded,
Failed, or Queued.

4. Select the file(s) you want to omit from OCR processing and click the Do Not OCR button.
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The file now displays on the Do Not OCR tab and will be skipped during OCR processing.

If a file already succeeded OCR processing and was then flagged as Do Not OCR,
TextMap will automatically update the index, removing the text previously indexed for
that image. Files flagged as Do Not OCR will not be reindexed when rebuilding the case
index.

You will not be able to search the content of an image that you have chosen not to OCR
process, but you can still view the linked image file.

The OCR status for the file(s) you have selected may have changed since you last
opened the Linked File OCR Status dialog box. If you select a file and click Do Not OCR,
and the status has changed, CaseMap displays a message for you to refresh the dialog
box to update it with current information. Click Yes. Once the refresh in complete, locate
the file(s) again, and if necessary click Do Not OCR again.

5. Click Close when you are finished.

To print a Linked Document OCR Status report

1. On the Case Tools menu, click Case Index.

2. On the submenu, click Linked Exhibit OCR Status.

3. In the Linked Exhibit OCR Status dialog box, click the tab for which you want to save
data: Succeeded, Failed, Do Not OCR, Queued, or Skipped PDF.

4. On the Report button, click the drop down arrow and select the report option you want:
Save Standard Report or Save Debug Report.

5. In the Save Report dialog box, navigate to the folder where you want to save the
report.

6. Click the Save button.

The file is saved as a .csv file in the folder you selected.

When you click on the Report button, there is an option for Save Debug Report. This
report option is for CaseMap Technical Support to use in resolving issues with a file that
did not index properly.

Related Topics

About OCR processing

Disabling OCR processing

Viewing linked exhibit index status
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Disabling OCR processing

TextMap performs OCR processing in the background while you are working and processes one
image at a time. The OCR processing feature is automatically turned on (enabled) for you.

You can disable this feature on your computer. Disabling OCR processing ensures that TextMap
will no longer attempt to OCR images linked to the cases you open on your computer. If you are
sharing the case with other staff, those users will still be able OCR process images on their
computer when they open TextMap. Once images are processed on other case users'
computers, you will be able to access them in the case.

To disable OCR processing

1. On the Case Tools ribbon, click Case Index.

You can also right-click on the OCR icon  (located in the lower right corner of TextMap)
when processing is enabled and click Disable OCR.

2. On the submenu, click OCR [Enabled], and then click Disabled.

 

3. In the message box, click Yes to confirm the action.

The OCR icon   now displays its disabled status .

To enable OCR processing, simply right-click on the OCR icon and click Enable OCR. You
can also click Enabled on the Case Index submenu.

You can also disable OCR processing by clicking the Disable OCR button in the Linked
Document OCR Status dialog box. The button then displays as Enable OCR. A message
stating that OCR processing is disabled will also display at the bottom of the dialog box.

Related Topics

About OCR Processing

Viewing linked file OCR status
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Managing Links to Cases

Changing exhibit file paths

Linked exhibits and other case files should be stored in a network folder so other case users
can access them. You can change the file paths using the Change Path Wizard, which will
change all matching paths to the new path so that links in the case will open specified
documents.

We recommend you make a backup copy of the case before making any global changes,
like changing linked file paths. Once the process is completed, you cannot undo the
changes without restoring a backup copy of the case.

To change exhibit file paths

1. On the Case Tools menu, click Linked Exhibits.

2. In the Linked Exhibits dialog box, click Change Paths.

3. On the Change Paths Wizard's Welcome page, click Next.

4. On the Select a Path to Update page, select the path you want to update.
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Select the Show whole path only check box if you prefer to change the whole file path at
once.

5. Click Next to continue.

6. On the Enter a New Path page, click Browse navigate to the folder where the files are
now stored, then click OK.

7. On the Enter a New Path page, click Next.

8. On the Completing the Change Paths Wizard page, review the previous and new folder
paths, then click Finish.

9. In the Linked Documents dialog box, click Close.

Related Topics

About exhibits

Linking exhibits to transcripts

Creating single hyperlinks in transcripts

Changing the case exhibits path
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Changing the case exhibits path

Exhibit files and other case files should be stored in a network folder so other case users can
access them.

For local cases, TextMap automatically imports exhibits files to a subfolder where the case file is
stored. If you move the exhibits folder along with the case file, the imported exhibits link will
still work. See Changing exhibit file paths.

For SQL cases, you specify the network folder where you want to store exhibit files in the Case
Properties dialog box. You must have permission granted in the CaseMap Admin Console to use
this feature.

To change the exhibits path folder for SQL cases

1. On the File menu, click Case Setup, and then click Case Properties to open the Case
Properties dialog box.

The current folder path for exhibits displays in the Exhibits Path box.

2. Click the Modify button to change the folder path.

3. In the Browse for Folder dialog box, navigate to the folder where you want to save
exhibit files, then click OK.

4. Click OK to save your changes.

Related Topics

Entering case properties

Importing exhibit packages

Changing exhibit file paths

Managing File Viewers

About file viewers

TextMap allows you to add native applications as file viewers so you can view native files in the
application in which they originate. The default viewer in TextMap is a Windows file viewer. You
can add additional file viewers, such as Adobe Acrobat, so you can view linked PDF files in
TextMap.

The File Viewers dialog box displays a listing of all programs that have been added to your
licensed copy of TextMap. You can add as many file viewers as you need to view the files and
documents linked to your case. Once a file viewer is set up in TextMap, you can view the source
file in the native application. If other users want to view that same record file, they will need to
set up the file viewer in TextMap too.
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To view the file, select the transcript it is linked to and then click on the paperclip icon to launch
the native application. The path to the native file is stored in the Linked Exhibits dialog box.

Related Topics

Adding/changing file viewers

Setting up custom file viewers

Adding/changing file viewers

The default file viewer in TextMap is Microsoft® Word. To find out if you have additional file
viewers set up in TextMap, click on the Tools menu and click File Viewers. The File Viewers
dialog box displays a listing of all programs that have been added to your licensed copy of
TextMap. Here you can add, remove, and edit file viewers, as well as change the default viewer
being used. Other users who want to view the same native source files need to ensure they
have added necessary applications to the File Viewers dialog box too.

We recommend you make a backup copy of the case before making any global changes,
like changing file viewers. Once the process is completed, you cannot undo the changes
without restoring a backup copy of the case.

To add a file viewer

1. On the Case Tools ribbon, click File Viewers.

2. In the File Viewers dialog box, click the Add button.

3. In the Select Viewer Type dialog box, select the viewer you want from the Viewer Type
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list, then click OK.

If the file viewer is not listed, select Custom, then click OK.

In the New File Viewer dialog box, click Browse to locate the file viewer you want to use,
then click Open.

Click OK to continue.

4. In the Select Image Database dialog box, navigate to and select the program you want
to use, then click Open.

5. In the New File Viewer dialog box, click OK.

The new file viewer is now listed in the File Viewers dialog box and you can now open
the source files associated with this program.

To set the new file viewer as the default viewer, click the Default button. In the
message, click Yes.

6. Click Close to return to the case.

To remove a file viewer

1. On the Case Tools ribbon, click File Viewers.

2. In the File Viewers dialog box, select the viewer you want to delete.

3. Click the Remove button.

4. In the message box to confirm, click Yes.

The name of the selected viewer is now removed from the File Viewers dialog box.

5. Click Close to return to the case.

Related Topics

About file viewers

Setting up custom file viewers

Setting up custom file viewers

TextMap allows you to select from a variety of industry file viewers, or you can set up a custom
file viewer too.

File viewers added to TextMap may be used by other team members as long as the application
is installed on their machine. For DDE (dynamic data exchange) and Command Line viewers, the
path to the viewer application’s executable must be the same on the other users’ computers.
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Choose from the following custom file viewer types:

Command Line is for applications controlled through command line parameters.

DDE is for applications controlled through the Windows protocol called DDE (dynamic data
exchange).

Script is for applications controlled through ActiveX scripting and/or Windows OLE/COM
protocols.

To set up custom file viewers

1. On the Case Tools ribbon, click File Viewers.

2. In the File Viewers dialog box, click the Add button.

3. In the Select Viewer Type dialog box, select Custom and then click OK.

4. In the New File Viewer dialog box, type the name you want to use to reference the
viewer in the Viewer Name field.

Make the name as short and descriptive as possible.

5. In the Viewer Type listing, click the type of viewer: Command Line, DDE, Script.

For Command Line and DDE Viewers

For Command Line viewers, you must provide the file viewer application path.

Click Browse to locate the executable of the application you will use to view documents.

When you select the application's executable, the full path to the executable appears in
quotes in the File Viewer Application Path field.

Type any applicable command line parameters after the full path to the application's
executable. Use the replaceable parameter %1 to represent the Linked File value.

For DDE viewers

For DDE viewers, you must provide you must provide the file viewer application path and
the DDE data required for TextMap to communicate with the file viewer application.
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1. In the Application/Service field, type the DDE application/service parameter value.

2. In the Topic field, type the DDE topic parameter value.

3. In the DDE Message field, type the DDE command(s) to open the viewer and display
a document.

Use the %1 replaceable parameter to represent the document Linked File value. The
%1 is replaced with the selected record's Linked File value when the command is
carried out.

For Script viewers

For Script viewers you must provide the following information:
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1. In the Script Language listing, click the scripting language used by the script code:
VBScript, JScript, JavaScript.

2. In the Main Routine and Parameter Defaults field, type the name of the script
code's main subroutine.

A description of the Parameter Defaults is provided in the default script code.

3. In the Script Code box, type the script code to communicate with the file viewer.

Please note the %1 replaceable parameter is not used by Script file viewers. The
value of the selected record's Linked File field is passed as parameters into the
script's main subroutine. Multiple parameter values must be delimited by the pipe
character in the Linked File field.

6. Click OK to save the new file viewer in the case.

The new custom file viewer now displays in the File Viewers dialog box.

7. Click Close when you are finished.

To set a default file viewer

1. On the Tools menu, click File Viewers.

2. In the File Viewers dialog box, select the viewer you want assigned as a default viewer.

3. Click the Default button.

4. In the message box to confirm, click Yes.
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The name of the selected viewer now displays in the Default Viewer for Cases area of
the File Viewers dialog box.

Related Topics

About file viewers

Adding/changing file viewers

Managing Case Tools and Options

About case tools

TextMap case tools are utilities that help make the process of transcript review and reporting
easier because they are built into the program. Many of these tools include wizards that help
guide you through process steps.

To review a list of case tools

Reference the Case Tools table to learn about each case tool and find links to procedural
topics.

Case Tools

Tool Description

Case Issues This tool menu item opens the Case Issues dialog box
where you can view, add, delete, organize, and import case
issues.

For more information see, About case issues.

Exhibit Autolink Aliases This tool menu item allows you to configure aliases on a per-
case level to automatically find links within a transcript.  For
more information, see Creating exhibit autolink aliases.

Linked Exhibits This tool menu item displays the Linked Exhibits dialog box
where you can edit, open, rename, delete, and change and
verify linked exhibit file paths.

For more information, see Editing exhibits, Verifying linked
files, and Changing exhibit file paths.

Case Index This tool menu item opens a submenu where you can view
case ignore words, track linked exhibit indexing and OCR
status, and enable/disable OCR processing, and rebuild the
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Case Tools

Tool Description

case index.

For more information, see Viewing linked exhibit index
status, Rebuilding the case index, Modifying ignore words,
Viewing linked exhibit OCR status, and Disabling OCR
processing.

File Viewers This tool allows you to add, edit, or delete file viewers. You
can also set a file viewer as the default.

For more information, see About file viewers.

Case Optimizer This utility defragments your case file to remove unused disk
space and increase speed.

For more information, see Optimizing case files.

Case Staff This feature allows you to add and delete case users.

For more information, see Managing case staff and Adding
users to cases.

Change Case Password This tool allows you to change the password for local cases.
SQL case passwords are set in the CaseMap Admin Console.

For more information, see Setting/changing case passwords.

Realtime This tool launches the CaseViewNet software that is
installed (optionally) when you install TextMap.

For more information, see About CaseViewNet.

Full Service Expert Search This tool allows you to access the LexisNexis Expert
Research On-Demand web site.

For more information, click here.

Customize The Customize dialog box allows you to change CaseMap
toolbar, commands, and menu settings.

For more information, see Changing toolbar buttons and
settings.

Options The Options dialog box contains several tabs for you to
customize case options.

For more information, see Changing case options.

https://idex.lexisnexis.com/requests/index.jsp?_requestid=18398
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Related Topics

Changing case options

Changing case options

Once your case is created, you can customize many of TextMap's features and standardize
them according to any internal guidelines, case needs, or user preferences.

To change case options

1. On the File menu, click Options.

2. Select the tab you need to adjust various custom settings.

See the Case Options table below for details regarding each options tab.

3. Click OK to save any changes.

To reference a list of case options

The following table provides a list of case options settings and their descriptions.
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Case Options

Tab Settings

General Select/clear whether to display a "No Transcripts" message reminder for
an open case.

Select/clear whether to display the Annotation Modes dialog box when
opening a case.

For more information, see Switch annotation modes to save time.

Select/clear whether to connect to CaseMap Server each time you open
TextMap.

Clear the case list of those recently opened in TextMap. This list displays
in the under Open a Local Case in the Getting Started pane. You can
also clear one or all cases from the list by right-clicking on one of the
cases and clicking Remove From List or Remove All From List.

For more information, see About the Getting Started pane.

Select the maximum number of transcripts to include in search results.
The default setting is 100 transcripts.

Transcripts Select/clear whether to display the transcript date and time in the
Transcripts pane.

For more information, Sorting transcripts.

Select/clear the Show filter box for "X" or more transcripts check box to
enable/disable the Filter Transcripts by Name box display in the
Transcripts pane. Adjust the minimum number of transcripts in the case
before the Filter Transcripts by Name box automatically displays in the
Transcripts pane when this option is selected. The default settings is 30
transcripts.

Select/clear whether to display the page number in the margin in the
Transcript window.

Clipboard Select/clear whether to include citation when copying and pasting
transcript text.

For more information, Copying data.

Select format to set the formatting preference for copied transcript text. 

Select the position to place the transcript citation After Transcript Text or
Before Transcript Text.

Ignore Words Add and delete ignore words for the current, local case. Import and
export the ignore word list. Once ignore words are added or deleted,
rebuild the case index.
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Case Options

Tab Settings

For more information, see About the case index and Modifying ignore
words.

Annotations Adjust the default setting for TextMap's Annotation Mode. The default
mode is Manual (Auto Off).

For more information, see Switch annotation modes to save time.

Select/clear whether to include page/line numbers when using the Send
to CaseMap tool to send text to CaseMap. The default setting is
disabled.

Select/clear whether to send an annotation note as a new fact text
when using the Send to CaseMap tool. The default setting is enabled.

Media Files Reference or change the drive that TextMap searches for video file
paths. TextMap can read video files from any location. It searches first
for videos that are imported into the case.

For more information, see Changing video file paths.

Select/clear whether to search the entire disc on CDs or DVDs.

Media Export Select/clear whether to use the FFmpeg encoder for exporting media
clips.

For more information, see Exporting video clips. 

File Locations Reference the directory location of case files, replicas, export and import
files, linked files, and video clips.

Modify the directory location of case files, replicas, export and import
files, linked files, and video clips.

For more information, see Managing/changing file locations.

CaseMap
Servers

View a listing of all CaseMap Servers registered in CaseMap. Each
server's name and URL displays. You can add, edit, and remove servers
here.

For more information, see Registering the CaseMap Server in TextMap.

Accessibility Select/clear whether to use the standard Windows menu for the main
menu bar.

Related Topics

About case tools
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Managing Videos

Changing video file paths

The video path is where TextMap looks for video files. The Case Video Paths dialog box allows
you to add additional file paths to search other locations on your system or network where
videos might be stored.

To add or change video paths

1. On the File menu, click Case Setup, and then click Case Properties.

2. In the Case Properties dialog box, click Video Paths.

3. On the Case Video Paths tab, click Add to add another location for TextMap to search. 

You can organize this list and edit it as needed.

4. On the Auto Search Drives tab, select or clear check boxes for drives you want to
search for video files.
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The DVD Drive and Search entire disc on CDs and DVDs check boxes are selected by
default.

5. Click OK to save any changes.

Related Topics

About videos

Changing search options for videos

Managing File Locations

Managing/changing file locations

TextMap keeps track of where you store your cases, including the case file itself, replicas,
export and import files, linked files, and video clips. You can check and modify the locations of
these files. And you can choose to automatically create new cases in a designated Case Files
folder.

To manage/change file locations
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1. On the File menu, click Options.

2. In the Options dialog box, click the File Locations tab.

Review the default file locations for all case file types listed. 

3. Select the file type you want to modify in the file location box. 

4. Click the Modify button to change the folder location.

5. In the Browse for Folder dialog box, select the folder where you want to store these
files, then click OK. 

Check the Make New Folder if you want to create a folder in which to save the files.

The file path location is now updated to the folder you selected.

6. Click OK to save your changes. 

Related Topics

Changing linked file paths

Changing exhibit file paths

Managing Accessibility Options

Changing accessibility options

TextMap accessibility options allows you to use a standard Windows menu for the main menu
bar instead of ribbons.

To change accessibility options

1. On the File menu, click Options.

2. Click the Accessibility tab, and in the dialog box, select the check box to enable the
option:

Use standard Windows menu for main menu bar

3. Click OK to save your changes.

Related Topics

About case tools
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Changing toolbar buttons and settings

Managing CaseMap Server

Registering the CaseMap Server

If you are using TextMap with CaseMap Server and did not register a server during TextMap
installation, you will need to register a CaseMap Server in the client application in order for
users to access SQL cases in TextMap.

To register a CaseMap Server

1. Launch TextMap.

2. On the File menu, click Options.

3. In the Options dialog box, click the CaseMap Servers tab.

4. Click the Add button.

5. In the New TextMap Server dialog box, type in the client server address in the Server
Name field.
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6. In the Server URL field, type in the path to the server, then click OK.

For example: http://[Your Server Name Here]/CMServer/CMServerClient.svc.

7. Click OK when you are finished.

The server you registered now displays in the Registered CaseMap Servers box.

To edit a CaseMap Server in TextMap

1. Launch TextMap.

2. On the File menu, click Options.

3. In the Options dialog box, click the CaseMap Servers tab.

4. In the Registered CaseMap Servers box, select the server you want to edit.

5. Click the Edit button.

6. In the Edit CaseMap Server dialog box, modify the server name or server URL, then
click OK.
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The changes now display in the Registered CaseMap Servers box.

7. Click OK to save your changes.

To remove a registered server in CaseMap

1. Launch TextMap.

2. On the File menu, click Options.

3. In the Options dialog box, click the CaseMap Servers tab.

4. In the Registered CaseMap Servers box, select the server you want to remove.

5. Click the Remove button.

The selected server no longer displays in the Registered CaseMap Servers box.

6. Click OK to save your changes.

To disable the Connect to CaseMap Server dialog box

You have the option to disable the Connect to CaseMap Server dialog box when you launch
TextMap. This feature is turned on by default.

1. On the File menu, click Options.

2. On the General tab, clear the Display Connect to CaseMap Server at start up check
box.

3. Click OK.
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Related Topics

Installing TextMap

CaseMap Server Answer Center

http://help.lexisnexis.com/litigation/ac/ac_portal/index.html?welcome.htm
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